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RTOS &L TKBIEREAD > TWB DT TIEHYEHAD ., ulTRON FZZZIEEXENAFLY TV LEICMHL
BOIENTWBOTRLLTEIEN HEES, TPPERS/ASP 1—FJLid, TOPPERS 7OV /A1) —2LT
WB R DA—*IL T, TOPPERS/ISP H—RILD#E#ME L TT YT T — M TN TWET, 5%, TOPPERS 7
OV MIZLDRRYME ASP A—FINELTEELTHAETZEESLTWET,

Z DX EIE TOPPERS/ASP #1—3JLD LPCXpresso 176x fkFERIC DL T, LPCXpresso IDE IC&2FI A D
FiEEHALET, COTOY I NORRY DRI IE TOPPERS/ASP for LPC 7OV TV MO AF TEET,

FREAICEFA T 2BRIRED OS (& Ubuntu 10.04 LTS TY,
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FFERDORBB/<EHICOANA.GPL2 A—RERABFICHEIFETEET,
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eabi-gcc £V /RAZELTHERLTWET, F7. LPCXpresso #{F A9 2155101k IDE H'F>TW 35 arm-
none-eabi-gcc ZFEALET,
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OV b R—=IlL Sourceforge ICE>TRAT AV T INTVWET,
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2.1 fRET BRE

ZDXETIE

® Ubuntu 10.04

® | PCXpresso for Linux v3.8.2 Build 129 (CodeRed)
® TOPPERS/ASP #—4"v NERTFER 1.6.0

® TOPPERS/ASP LPCXpresso &K1FE8 1.6.1

HERIALBRRREOEBELHALEIT . AAMNIVE21—FIIWET S DM VMware Workstation 7.0 £
DIREY >V TEH LPC-Link ICEB9—T Y DTNy T ARETHD I EEERLTWET,

2289—=vh-N—Fox7F

H—4yh-N—Rz 7L LPCXpresso 1769(EE 1)TY,

ZOR—RIE, 2010 FICERFEIN T LPCXpresso 1768 DM EIR T MO WHR L RINTLZEDD,
YAAVHLPC1768 15 LPC1769 ICEEINALUSMIRLTY . LPC1769 1E LPC1768 DEEIRTHY. A
SREA 100MHz A5 120MHz ICAE EL7=Z & & RRIFIE AE YRR RY 7T IVEBM. EVEREBFT—H#TY,
#E /. LPCXpresso1769 I& LPCXpresso1768 DE&ERE L THEXE T,

LPCXpresso 1769 [ZIZIFHRTZHZILTEIBEHKE T, ZDHF A USB IRV I ERMIN TV,
LPC-Link EMEENZ T /Ny H - R—RELTEIEET  RYDHA NI —T v 2B (IAVR—RTY,

EVid 2.54mm EYF—FNDED DR ZAFAMSTTEY, TLyRR—RICRILTHEIENAERET,

LPCXpresso1769 L BB AF AR B TT . MERDVav T THREINTWRIEFNERTHEATIEELH
RES, i IE 72N 2L 3000 HIFETY,

EHE 1 LPCXpresso 1769 E#x
23 Linux DINSEERE
BRBIEICIE Linux DT 4 AN E2—>3>v®D—D2, Ubuntu 10.04 ZfEWET,
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Ubuntu 10.04 IZZDRF1AY MDOBEEETY ) —ZAHTTIC 1 ENRBLTBY. RFEIIEZFEA.
LD L. ZDhRIE Ubuntu 7OY Y hA° LTS( Long Term Support) LR REFERTHY. VY—IHS 3 45
Bt¥a) 717y TF—MEETIBFMHRINTOE T HFEOEBAIENRY, VIO PREFICIE LTS
hRZEEIHFHANNTLED,

Ubuntu 10.04 DAY Xk =)L CDAA—JIZ UTOR—IDNOIGHES Y REBERTT A MBLE
Ubuntu i34 Zh—JVBSICIEE S MIFAAREBRIEE LTEATEET,

CDAX—Y%AF LIS CDICHEEET 2D CD AHT—hFBIETEYIUA Ubuntu 21V AM—ILT 5
ZENTEEY,

®  http://releases.ubuntu.com/jaunt

BHAEE Remix lRDADVNNEWDIFIK ZE5EH L TAHBDOEEBWLTLED,

®  http://www.ubuntulinux.jp/products/JA-Localized/download

EIIVIZUbuntu A ANBZEICERET 525X, VMware Player #5826 LE T, VMware £ TH USB
ICEAF 222 5MALTWET ', VMware Player 3.0 B SRV VA ENDLIICARYELLDT A1V R
M—ILIZEETY,

®  http://www.vmware.com/jp/products/player/

VMware Player £IC Ubuntu 24V A M—=)LF2HEIZ. RYMIRIUEHRABHYETDTEESESIBL T
IV, —DOBIELTUTOR—IEBNLTEEET,

®  http://d.hatena.ne.jp/suikan+embedded/20100620/1277043924

8. VMware Player ICA VA=) T2DTHNIL, CD A A—T% CD ILFEK B EIEHYFEH A, VMware
Player 34 X—2 - 774)L% CD ELTR IV NS BZENEERET DT, ¥y O—RLEA XA—IUDSEREREY
UERBBHRET,
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NIEET TINART—RERDLNTZH A S LTSI,

T HEERL7=DIE VMWare Player Tld7:<. VMware Workstation 7.0
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sudo apt-get install doxygen g++ ckermit libboost-all-dev 1lv
echo set line /dev/ttyUSBO > ~/.kermrc

echo set speed 57600 >> ~/.kermrc

echo set parity none >> ~/.kermrc

echo set flow-control none >> ~/.kermrc

echo set carrier-watch off >> ~/.kermrc

ERDORVV T ERITETEE AV TAF 2L —IDEILRICBRERY —ILITINA T, kermit DEFTICHEREK
ELEMINFT,

BB D kermit DEREIL /dev/ttyUSBO ICEHINAR—NeERT2/20DEDTY, BIDOR—~&EH
TEBAEIL FEET "/ kermre HIRELELTEIL,

2.5 Libftd2xx DRBEIV A=)

LPCXpresso IDE £, 2010 &£ 5 BB =T Linux @ libftdi 475 &&= L. RFO USB ) 7L HE
T Ty RGN BB E RO TWET,

OB FIDI DO Fv T EFBLEVITIVEBRTY TITOIHFEELET, LPCXpresso IDE DEGEE &
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CORIRBEER T BICIE, FTDI 4 A B4R L TUW Linux A D libftd2xx RS/ & E A LE T, Libftd2xx K54
NDAFEAVAM—IVICEAL T FTDI #DIFRESRL TS,

®  http://www.ftdichip.com/Drivers/D2XX.htm

libftd2xx RS A/ EEIIFEE, USB BT Y T3 /dev/ttyUSBx (x I EH) BRI ITONES . RIDD
T Y TIDERNE /dev/ttyUSBO IZRYE T,

2.6 LPCXpresso IDE DR EI Y A =)L

HRARRIBIETHSD LPCXpresso IDE IE, CodeRed D WEB H A hAS4 v O—RLEYS . COXETHERL
TWaDIk LPCXpresso for Linux v3.8.2 Build 129 T4,

® http://lpcxpresso.code-red-tech.com/LPCXpresso/
&FovO—RIE THIYMERDBETY, ¥ O—REOFEVWAICEALTIE. NXP ORFaXVMNESHEL
TLIEEW,

®  http://ics.nxp.com/support/documents/microcontrollers/pdf/lpcxpresso.getting.started.pdf

2.7 Eclox D14V A=)l

Eclox |£. Doxygen % Eclipse ™SERT27HD TS 71V TY,

AV ZAR—)LFBE Doxygen AAV MDAV NIV D FRET7AIVDIAHF =R I5—AvtE—IP5IT5—
BERIANDY v TR EDHBENBININET,

CMSIS 47 Z1* TOPPERS/ASP for LPC |4 Doxygen X & %ER L TW57% 8, Eclox & LPCXpresso
IDEICAYAM—ILLTHELZEZETITHOLES,

AV AM=VEEL T OFIRTITVET,

F9 IDE D XA X=a2—h5, Help->Install New software: #E{TLET . RICIBN /Y4705 D Work
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with 74—JURIC http://home.gna.org/eclox/#update-site # A AL TIVH— -F—EMLET, FFE LD
BNEDS Add REVMLTAALET (E 1),

LIE5<T5E, Name DT A Pending--H5 Eclox ICEELET DT B LS. FTvIRv I A EF Ty
ILTAVAM— WV EEDE T HEFFETICH S TR TS Eclox DAY Rh—)UIZH T LET,

Doxygen ¥ Eclox DEWAHICELTTIEEP XYM LDBHRESEICLTEIW,

Available Software

Select a site or enter the location of a site.

Work with: |http:,f,fhome,gna,orgfeclox,f#update-site ‘ v

Find more software by working with the 'Available Software Si

(D There is { ;
Name: |Eclox| | Local...
Location: Ihttp:,f;‘home,gna,org,feclox,f#update—site | | Archive... |
@ L Gamel || ok |
Details

Bl 1 Eclox DAY AM—JL

2.8 Subversive DAV A k—Jb

SVN &L =W A, Subversive 21V ZAR—ILE2EEWTLED,

Subversive IZ. Eclipse M SVN 7547V M T, SVN H—N—ED 7OV I EDREEADIFH, SVN H—/N
—DTZIX N—=IaVE DR E DB REINET,

AV AM=VEEL T OFIRTITVET,

F9 IDE D XA X=a—h5, Help->Install New software: #E{TLET . RICIBN /Y1705 D Work
with 74—JURIC http://download.eclipse.org/releases/galileo/ A AL TV Y —-F—%HLFET, DEL
WIMEWE DS Add REVIELTAAILET,

LIE5<T3&, Name D TA Pending: - HSY 70z 7D —EBIZE{LLEF T DT, Collaboration ZR&BIL
T.”Subversive SVN Team Provider” #2BRLTIVRAM—ILLET (K 2),
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Available Software

Check the items that you wish to install.

Work with: 'http:ﬁdownload.eclipse.orgireleasesigalileo

Find more software by working with

Name Version
SHEETIYIYTD Taok LIS VICyurieuy daL L VEIULUUL L U LT,
L Mylyn Task-Focused Interface (Recommender 3.2.3.v20100217-0100-¢
L Mylyn WikiText 1.1.3.v20100217-0100-e

G+ subversive SVN Integration for the Mylyn Pro 0.7.8.120091023-1300
< 4% Subversive SVN Team Provider (Incubation) | 0.7.8.120091023-1300
000 Database Development
00 EclipseRT Target Platform Components
000 General Purpose Tools
00 Mobile and Device Development

+ o+ o+ o+

+ mn Madelinn

2 Subversive DAV A h—JL

HERFFREITHS>TIVAM—ILLET,

IT. Subversive 13771 DMIC, Connector ERHENZY TR I 7 HAV ARN—ILEBETIEEZIEEA -
Connector 4~ ZAh—JL 9 %ITIE IDE D A=2—h'S Window -> Open Perspective -> Others:-- #£{TLZE
T, %99 D& Eclipse D/IS—ARIFT4TD—EBELFHLHLNFET DT, Show all FxvIRyIRAEFzvILET,
ZLTHN ) XMHS”SVN Repository Exploring” Z2IRLET (K 3),

£ Open Perspective

0B c/c++
[ CVS Repository Exploring !
%5 Debug

A Develop (default)

@ Planning

[?5 Resource

{=% SVN Repository Exploring
£9 Team Synchronizing L

how all

3]
L

p—

Bl 3 SVN Repository Exploring
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OK %#9 &, SVN Repository Explorer B X, 72725612, Connector DAY A~— )L -
FA47O7HF<DTSYNKIT 1.3.0 BATIVAM—ILLET (K 3),

® Install Connectors

Subversive Connector Discovery SVN
Select connectors to install. Press Finish to proceed with installation. ?‘
Press the information button to see a detailed overview and a link to more information.

Find:

SVN connector based on SVN KIt library (SVN/1.4.X SVNKIt/1.1.7 r4142). _
Compatible with SVN 1.4.x. Pure Java. Supported platforms: All.

SVN Kit 1.2.3

by Polarion, TMate Open Source License @) -

SVN connector based on SVN Kit library (SYN/1.5.6 SVNKit/1.2.3 r5745).
Compatible with SWN 1.5.x. Pure Java. Supported platforms: All.

4]
&

SVN Kit 1.3.0 by Polarion, TMate Open Source License @) [

SVN connector based on SVN Kit library (SYN/1.6.2 SVNKit/1.3.0 r5847).
Compatible with SWVN 1.6.x. Pure Java. Supported platforms: All.

JavaHL 1.4.x by Polarion, Apache Software License 1.1 @

SVN connector based on JavaHL. Compatible with SVN 1.4.x. You also need to
manually install Subversion, including the JavaHL library, for your platform. e

JavaHL 1.5.x by Polarion, Apache Software License 1.1 @

SVN connector based on JavaHL. Compatible with SVN 1.5.x. You also need to
manually install Subversion, including the JavaHL library, for your platform.

JavaHL 1.6.x by Polarion, Apache Software License 1.1 @

SVN connector based on JavaHL. Compatible with SVN 1.6.x. You also need to
manually install Subversion, including the JavaHL library, for your platform.

@ | Cancel  Finish |

4 SVN KIT 1.3.0 &R
ARV %AV A=)V F B &, Subversive ZF>T, IDE EASH—N—DFOV I MNEFIATESLDITARY
F7,
Subversive ¥ SVN OEBRDHEV AL Eclipse BEEDEZEFE PRy N EORRESEICLTIEIL,
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3 TOPPERS/ASP for LPCXpresso D B 15
TOPPERS/ASP for LPCXpresso #BE 35— BLWHEKIK V) —RFHOHY Y TFIL- OIS L% o0
—RK932ETY,
®  http://sourceforge.jp/projects/toppersasp4lpc/releases/?package id=11898
CONEDHERETRFTDY Y FILIE Sample_LPCXpresso1768_20110507.zip T3, ¥ O—RT
3&.zip 77MIVBATHBZEN OOV FTH, COFXICLTERMIFLEE A,
DY YT T DEIRBERANLHEO>TVET,
CMSIS 2.0
TOPPERS/ASP 1.6.0 + LPCXpresso 1768 {&K#Z&B 1.6.1
RYZTSI BTV AT L

ASP 7 ) r—oav- ALk

ASP 7T r—ay 47

CMSIS £ ARM # 2'BAF L7z CORTEX-Mx BDSATSUT. LY RIANDT I/ R%EFHLT 27 o0
DSP FERABA E2>TVWET NXP FZDFITIVICHRBORI 7T -TIER- /OB LR ERHE
BlEEA /v T—Y LTERABLTWET,

TOPPERS/ASP for LPCXpresso @ CMSIS &, NXP H' B2 L CLA % CMSIS % LPCXpresso IDE BICEJLR
LABLEEDTT, —EHNTEBELTOETHNAERDI—RIE NXP BLUARM H'EFKLALEDTYT, BEH
THHEP. BAEDOBRIE NXP BLUARM OF1 Y ZUHE>TEIW,

TOPPERS/ASP 71— JLId, TOPPERS 7AY T/ MIkd STM32F103 ADR—F AV T ETTIC, §—4 v MK
FER% LPC1768/1769 RICHBIELELLEDTY,  MIASLUEERA X TOPPERS 7OV T/ hDS1 Y RUC
ST,

RYFTS5)-H TV RAF Ll CMSIS & L7 TOPPERS/ASP BDS4 75T RIEDA 12C ADSA7
ZUNHBRINTLET,

INSE[F LT r—avOBMER 5 ISRLET,

SL="f=
TI)r—ay
RY)7x7)b
YT RAT A

TOPPERS /ASP CMSIS
h—xI 4T3

LPC1768/1769

B 5 705 L08R
ITHYTI-TOTVS LD zip 77V &S O—K LIS, IDE BMSAVR—KLET,
AVR—KNI IDEDA=a—»5, File=Import #ETLET . T5&., Import ¥4 7O DHEZET DT,
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General—Existing Projects into Workspace %32 A T Next ##LE 3 (B 6) . :BIRT 5D Archive File T
[%72< Existing Projects into Workspace TH2ZEITEELTEIW,

Select N
. . ) -
Create new projects from an archive file or directory. H

Select an import source:
type filter text

- = General
[ Archive File
[ Existing Projects into Workspace
[, File system
&% Import projects(s) from XML description
E. preferences

= C/C++

= CVS

= Run/Debug

= 5VN

= Tasks

+ o+ o+ o+

® T

B 6 Import¥470%
ROTATOYT TEHRIMAL zip T— AT EIBELTPRE T—IAR—AANDZHFAFD R T LET (H 7).,

[t5 Project 52 i Core R | &, Periph | © O || @ Welcome &3

B k& = & [fle

15 000 samplel

+
+ =010 blink

+ =011 blink_cmsis X

+ =801 i2c_pcf8570

+ =802 i2c_max518 i
+ ;=999 asp_skelton Please note:

+ 15 cmsis An unactivated product may o
+ 7= subsystems Activating your product

Your product is not acth

Naote: You wil need to h
activation code.

To activate your produc

1. Help->Product ac

770V mBRABTET

11
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4blink DEILRERFT

4.1 blink [CDWT

#H . TOPPERS/ASP 7 7)) 7 —av &R LILHE>THBEXITIL, Samplel EIEENZ T Y r—oav & E
WET LALARAS. COT7FYr—2avilidEv )7L -R— DA BRETHY. —H. BE>LFED
LPCXpresso1768 ICld PC LRI Z7DDI YT IL-R—rhHYFEH A (UART i FIdH TWB A, PC &R
FTRITIELRIVERD USB VYT IVEBRPBE),

ZZ T ®AIC LPCXpersso1768 M LED A =RB St 377U — 3, blink 2L RLTHEL &L, Blink I
010_blink 7OV 2/ hELTH YT IV - TOT S LIIEFINTWET  ZOTAV I ME CMSIS HEH TV RF L
£{EH 9" TOPPERS/ASP DHAE T TEIELE T,

42 F4L IR

TTVT—2av DT 4LIMNBEBRIELLTOLICA>TWET,

[~ Project 2 Wi CoreR |2, Periph | = 8
=l 5 =

+ 1= 000_samplel

- %010 blink

@ Includes

= Debug

& kemnel

app.h

[ blink.c

[ kemnel_cfg.c

kemel_cfg.h

offset.h
010_blink Debug.launch
010_blink Release.launch
blink.cfg
config_project
kemel_cfg.timestamp

& Makefile
Makefile.depend
README

+ 3= 011 blink_cmsis

+ 725 801_i2c_pcf8570

+ 1=802_i2c_max518

+ 1=999 asp_skelton

+ £ cmsis ¥

T
T
T
T
T
T
¥
T

8 F4LUMNIMER

HT T 1L IR kernel ITIE ASP H—R LB BWTHYET,

H—4y MRIFER L lpcxpresso1768_gec T, LPCXpresso IDE TN DICHRITAIZALIED T Z
DI =5y MRIFERIE REBD RC FEAR2F%E>T 100MHz TEIFLE T LPC1769 I3 120MHz TEMELE T A,
LPC1768 & E#ilt % &27-6IC TOOMHz ICHIRL THY ET,

7Y r—23>®Y—ZAO—NKIE blink.c & app.h TY, TDIFHAIC kernel_cfg.h & kernel_cfg.c BHYET

12
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. ZNIE TOPPERS @AV 74FaL—4DEBERLEEDTHY . TS r—ay - TOI S dMEo726DT
lEHYEFABL offset.h EAV T4 FaL—IDEKLIZEDTT,

AV 74F2L—9DY—RTH? blink.cfgld. Y RIPEITEEETE 77T . ZhET7 ) r—vav-
TOUSIAARTRZEDTT,, AV T4F¥1L—YEIDT7M I ESRL T Makefile #EYHLET,

A3F7F)r—2avoELR

TTVr—avDOEIRIIEETT,

7OV ERRL. 7OV I/ —BDTICH S build 010_blink” 22Uy 3 hIFE L RAEEVET (K
9) V= DN=I3VEDIATYFHIRINIE ENNRIERER<ER T T3 TT.

ELVRDERLES Y=y MIO—RL TN L THTKEIW =T Y MADO—RFERT NV I HEE .
LPCXpresso IDE DRF AV REHEITLTEI,

) Quicks 22 ™_®-=Variabl | ® Breakp| = O
~ & Start here

&jNew project... v

® Import Example project(s)

it Build all projects [Debug]

%, Build '010_blink" [Debug]

o +£ 010_blink

T ¥ Fovn—kKv

B9 ELNRDAEE

443V 74F21L—9QEILREaYT4F2L—YaY

A3 TOPPERS/ASP T—&HEAIADIEAY 74F2L—2av T, INIARYBI TLEAIE RTOS DHW
LIEFERHEDITENTEXT,

LAL. AV 74F2Lb—2ary THOWTREETLE TR ES VW RVD T, ZOY Y FILETIEOY 74FaL—
2avEHOTOAVIIMNRELTCVWEY, — AT 24— 7V r—ava B THET RGOV 74F
A= avEBITTRBIEIEITEEE A

AV 74F 2L —2avid T TICBAR I LIICEBIREETT NS A—SERIZ0EEEITT O T BEIKL
T#% TOPPERS 7OV T/ MDRFaAXAVNTCHREL TWARLKELT YV TILETIE config_project EWH RS
DTN T4V T4¥ 2L —Ya v OFHEEEDBLTVET,

AV 74F 2L =23Vl >TUE TOPPERS DAV 74X aL—9 DB UBEITHRYETA BMWNEGEITIEEILRY
BEICRV) TR EEVWTVET,

LPCXpresso kA 2L 7OV I MNEREZBICE, AV 74FaL—2 a3V BIDRDIR VY RERITLET,

13
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make depend

ZN T LPCXpresso IDE TOE L RN AREICAYET,

BE.TOVIIMIE>TIE make AXYRTREEFTEILRT B TEEHE A, TOPPERS/ASP for
LPCXpresso I& IDE TOEJLRAERHREELTWS 8, ATV R - SAVTOBRERELR/IRICLTUWSNSTY,
ESLTHEOARYR-FAVTENRETWZWEEITIE. Makefile.target DR TA VI —R-T74ILD/RZAPE
NS4 75) ERELTHTZIN,
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5 Kermit IC & 2 BN {FFEER

TBRBIEOHEE | TR LERIYTME Kermit DEREEA VY AR—ILETVWET, VYTV -R—bEHEEL
TohiE, Kermit 2> T sample1 OEIEHERATITENTEET,

RIS, ZZTEHAT S Kermit ITIE—DFIR A H B EITERE LTIV T ILBER— DA
BIEEE TH o7/, Kermit DR ET7AIVERE L ZRIDVITIL-TINARAESRBLES & IB3D . &EE
MDUSBUITIV-THTIDZE WBWBRERTT A RADERINEDYET,

ZRIERDBERBRERIE. VTV -TNARELTREBRICV AT AICRBINDEEITETY, DA
YAN=I - ZZY TR T D) T IL - R— D ZRTIE” /dev/ttyUSBO” ICEE L TE>TWE T, USB VU 7ILE
BT THEEBEIISBEITIE YT I - R—bELTEIEDER I AT LITHETLOICLTESIL,

Shell 15

kermit

EANTBIET kermit ZRETEF I EBBERITI——IVVREZFO>TVWETOT AV RTIRKR
E—RICBITLTLEIW HERE—RNSRESICIE. TR —7-av Y R"CTRL-¥ C" 2 A LET,
A4ICV)TIVBEDKFERLET (FERLTWADIRBIDTAEYTEDA—XILTT),

I7IUE) @REE) BTN WRI) LT

C-Kermit 8.08.211, 10 Apr 2004, for Linux [~]
Copyright (C) 1985, 2804, ul
Trustees of Columbia University in the City of New York.

Type 7 or HELP for help.

(/home/takemasa/) C-Kermit>c

Connecting to /dev/ttyUSB@, speed 57608

Escape character: Ctrl-\ (ASCII 28, FS): enabled

Type the escape character followed by C to get back,

or followed by ? to see other options.

=

TOPPERS/JISP Kernel Release 1.4 (patchlevel = 3) for KOBANZAME (J-DSP-BF533SEB) (
May 23 2010, 22:23:22)
Copyright (C) 200@-2883 by Embedded and Real-Time Systems Laboratory
Toyohashi Univ. of Technology, JAPAN
Copyright (C) 2004-20806 by Embedded and Real-Time Systems Laboratory ||
Graduate School of Information Science, Nagoya Univ., JAPAN
Copyright (C) 2004-2810 by TOPPERS/JSP for Blackfin project
http://sourceforge.jp/projects/toppersjspdbf/

System logging task is started on port 1.
Sample program starts (exinf = @).

taskl is running (881). |

taskl is running (882). |

taskl is running (8@83). |

taskl is running (884). |

taskl is running (B@85). |

taskl is running (B86). |

Bl 10 kermit TYYZIEEEZITO>TWBEZS

[
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6 CMSIS & SUBSYSTEMS 2f§>7%&T7FYDEIR

4 ZTIE TOPPERS/ASP I3 &E >/ 7 Y DE I RETWE LIz, ZOETIE, CMSIS &1 SUBSYSTEMS
EES7 7T )DEILRETVET,

6.1EIKFIE

FIEZDELDIEEE T, 7TYDEILRDETIC, cmsis 7OV TV hEEJLRL, subsystems 7OV TV hEE LR
LTHELLEFTT . ZOZ207Av I MEWg i Static Archive THY, EILRTZE, TR EFh libecmsis.a &
libsubsystems.a Z%E R LEF T EZICT SV ELILRLTEDYTT,

FTTVr—avhbRBE, libemsis.a B, libsubsystems.a b, B3 7 —hA4 7T, 7S Ur—avik. 70
N4 EF>TCIDZDDT—AATAFERATEIEEEELTCWET F . T— AT ICEET IV I —R-7
FAIWEFHFALTHD/RAEEBMLTVET,

CMSIS & SUBSYSTEMS A #5777 DFlELTIE, 7AYo/~ 801 _i2c_pcf8570 H*HYET,

6.2 801_i2c_pcf8570 DAY 74F¥al—¥aYy

FaY Y b 801 _i2¢c_pcf8570 AV T714¥al—ay - T74)l i2¢c_pcf8570.cfg & TV AT LD i2¢c 7
29— HBEAFER T 572, i2c0_m.cfg ZFHMAATUVETS,

FAIAEN TV i2c0_m.cfg & subsystems 7OV T/ MR T2V 714F2L—2a> - T7MIL T, 12CO
RYTISNEIRAY—ELTERT2OOMPILIL—F 2 BLVEIYRAANY RS ERELTWET, IV T
Falb—2av - T7MIBHBODNDREEITOTLEI LD . TTYI—2aVAITIE 12CO BOEVEREI AL
TLEARHE I FHAEZBEREEDILFITR>TVET,

EVEEEHY T RATARBDAZ v A PICIEFTICT TV r—2ar TIToTWBDIEL, 12CRY TS IS
FoTUI EVDEIY ETHEDNERHEINOTY . INEAZ v TM Y TROITELTLEd>EI—HF—DEHRE
NFEBYET,

YTV RATFLARBEDOAY 74X =23V - T7MILIETTITBN LT DO DOMIC i2¢1_m.cfg 8LV
i2c2_m.cfg B’HY, FNTNI12CT1.12C2 RY TSN ERRY—ELTERTBRITHENET,

YTV RTFLARMBOBEICEAL T YTV AT ADY—RO—RICE B IN 7 Doxygen IAV M, HBULME

Doxygen XE%SBLTEIW,
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THMEF7IIVr—vavaEd

TOPPERS/ASP for LPCXpresso D7 7)o —av B, EAXRMICITMD TOPPERS/ASP 77U r—a
VEFEERLTY,

7=72L.IDE DR EFFEICEEITT . T T.COETEBREDOT ) r—vavaryFL—he LT HEBT
TVr—2avEEdAiEEHRBALET,

1157V L—hERBTTIVr—ay

BNCT VT L—RERD TS T—2av B UEY,

TUTL—NMITETTIVr—2avid taATDHICARINTWS 999_asp_skelton ZFESDHIELHTY
P ARDYIHDOT TV —2av aEoTENEVERALRELERTE7 A1 T DBREPIVIIL—R-T74
IWDEREEZE Z2DE.999_asp_skelton 2 i2c DYV FIL-TOATSLHSERATEIAIVWTLLED,

[ A MO D E SN

TUTL—MITRTOVIINERD S RICEOTOV I EHF LW IOV I MRICY R—LLET,

O AE—TIRYR—LETILOITE DI TWEIV,. OV I MNE) X — LT B5E. IDEIFYR—L4
IKHLTTOY I MRE DR RAEEERB L T—ERZREIELET. LML AE—ELABEICIEIN D TH
NEFAMBRBICA VI —R - RRABEDOBRENVERENS, TOVIIMDIE—ZEICEDRVEET
D

737V r—2av - 72740 DY x— LA

TOPPERS/ASP DAY 74F¥ L —8IE -ANRSA—ITT T ) r—2av BB ELEFTN . COEX. 7T r—
AVR.CBLUT I r—2aV R .cfg EEDRRIDI7AINDEAEERI>TWBRELSHYET L& 2L,

Kernel/configure -T lpcxpressol768_gcc -A FOO

EELEZE.FOO.c BLUFOO.cfg ZAEBELRITNIETRYFEA,

DD TV r—2aVEEI7AIVERPTBHEITE. CDON—ILITRIBEDNHYF T, BRI
® V74X alL—av 77 I(cfg I7AIV)DEFET T ) r—av&ilahts

® config_project 771 JLIREBD configurator A2 FrD-ABIE AT T ) r—av&ild3
ZDZDDEEETFB UTOIAYYRETAY I TALINRETERITLET,

make clean
./config_project

INTHLWI OV IV MNRICRRIAEADIENEEF L,
v 74F2L—2arddFE W25, IDEDSEILREESIZTTT,

TZHELIZASP H—RIL D doc BB FDTFFRAMESIRLTLIEXL,
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8BDHYIC
8.1 B
® 20114 5H 8H LPCXpresso1768 #&k7z%8 1.6.1 &I,
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